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This post discusses Teams Chat’s often underutilized but precious feature - the text formatting toolbar. This feature lets you make your messages more expressive and clear, with options to bold, italicize, and underline text, create bulleted or numbered lists, and much more. Let’s look at how to use the text formatting toolbar on desktop and mobile
platforms, along with some valuable tips and tricks. Step 1: Open Microsoft Teams and navigate to the chat where you want to send a message. Step 2: Click the “Format” button below the text box where you type your message. This button looks like an ‘A’ with a paintbrush. Step 3: The text formatting toolbar will open above the text box. Here, you’ll
find options to bold, italicize, underline, strike-through, highlight, and change the colour of your text. You can also adjust the alignment of your text, create bulleted or numbered lists, insert a link, or clear all formatting. Step 4: Write your message in the text box, using the toolbar to format your text as needed. Once finished, press ‘Enter’ to send
your message. As of my knowledge cutoff in September 2021, the mobile version of Microsoft Teams does not offer a full-text formatting toolbar like the desktop version. However, you can still use basic formatting in your messages by following these steps: Step 1: Open the Microsoft Teams app and navigate to the chat where you want to send a
message. Step 2: In the text box, you can use markdown language to format your text. Here are a few examples: To italicize text, wrap it in asterisks like so: italicized text To bold text, wrap it in double asterisks like so: bold text To create a strikethrough, wrap the text in tildes like so: strikethrough text Step 3: Tap the ‘Send’ button once you've
written and formatted your message. Quoting Text: You can quote text in your messages by clicking the ‘Quote’ button in the text formatting toolbar on the desktop. This is especially useful when responding to a specific part of a previous message. Using Headings: The text formatting toolbar also allows you to create headings (H1, H2, and H3) to
structure your messages better, especially when sending lengthy or detailed information. Inserting Code Snippets: Use the ‘Code’ button in the toolbar if you share code. This will format your text as a code snippet, maintaining the proper formatting and making it more readable. Adding Emojis, GIFs, and Stickers: You can also add emojis, GIFs, and
stickers to your messages to make them more engaging and expressive. Keyboard Shortcuts: If you prefer keyboard shortcuts, you can bold text with Ctrl + B, italicize with Ctrl + I, and underline with Ctrl + U on Windows (or Command + B, Command + I, and Command + U on Mac). By mastering the text formatting toolbar, you can make your
messages in Microsoft Teams more structured, clear, and impactful. Happy formatting! In the digital workspace, maintaining clarity and efficiency is essential, particularly when sharing ideas, collaborating with teams, and organizing thoughts. One of the useful formatting options available is the strikethrough feature, which allows users to indicate
deleted, irrelevant, or reconsidered items without erasing them entirely. This article will cover the strikethrough shortcut across various platforms, particularly focusing on Google Docs, Microsoft PowerPoint, Windows Sticky Notes, and Microsoft Teams. Understanding Strikethrough Strikethrough is a text formatting option that displays a line
through the text, indicating that the content is no longer relevant or that it has been crossed out for some reason. This can be particularly helpful in collaborative environments, where multiple users edit or review documents. Strikethrough serves not only as a visual cue but also as an efficient way to demonstrate progress or changes in thought
without altering the original document structure. Strikethrough in Google Docs Google Docs is a widely-used word processing tool that offers an intuitive and collaborative writing experience. Using Strikethrough: To use the strikethrough formatting in Google Docs, you can either rely on a keyboard shortcut or use the formatting menus. Here’s a
detailed process: Highlight the text you want to strikethrough. Keyboard Shortcut: Press Alt + Shift + 5 (Windows) or Command + Shift + X (Mac) to apply strikethrough formatting quickly. Using the Menu: Navigate to the top menu bar. Click on “Format,” then hover over “Text.” From the submenu, select “Strikethrough.” Once you’ve applied the
strikethrough, the selected text will display a line through it, signifying that it has been removed or is under consideration for deletion. This method is essential when editing drafts, where accountability is critical, yet you still want to keep a record of every idea. How Strikethrough Enhances Collaboration: The strikethrough feature can be particularly
useful during group projects or when feedback is involved. Editors can indicate changes clearly and allow readers to understand which suggestions have been considered and which have been discarded. Strikethrough in Microsoft PowerPoint PowerPoint is another essential tool in the Microsoft Office Suite utilized for creating presentations. While it
is primarily visual, incorporating strikethrough can enhance clarity and indicate changes in presented data or ideas. Applying Strikethrough in PowerPoint: Select the text you wish to modify. Keyboard Shortcut: Use Ctrl + T to open the Font dialog box, then click on the checkbox next to “Strikethrough.” Alternatively, use Ctrl + Shift + X as a
shortcut to apply strikethrough directly if you have the latest version of PowerPoint. Using the Ribbon: On the Home tab, look for the Font group. Click the strikethrough button (represented by an “ABC” with a line through it). Strikethrough in PowerPoint is particularly effective when presenting lists or ideas that have undergone revisions. Audiences
can visually follow along and see what concepts have been abandoned in favor of new directions. Practical Applications: Using strikethrough in presentations not only helps in decluttering the slide visually, but it can also effectively convey the iterative nature of developing ideas. This demonstrates to the audience that concepts evolve, fostering a
better understanding of the thought process behind the information being presented. Strikethrough in Sticky Notes Microsoft Sticky Notes is a simple yet effective tool for personal note-taking and task management. Employing Strikethrough: Write your notes in a Sticky Note. Highlight the text you wish to strikethrough. Keyboard Shortcut: Ctrl + T
(Windows) to apply strikethrough formatting. Sticky Notes is an excellent tool for managing day-to-day tasks. Using strikethrough allows users to mark completed tasks without deleting them. This not only provides a sense of accomplishment but also supplies a record of what has been achieved. Benefits of Strikethrough in Sticky Notes: In a rapid-
paced environment, having clear visibility of what has been completed vs. what remains to be done can enhance productivity. The visual representation through strikethrough makes it easy to skim through your notes and identify priority tasks. Strikethrough in Microsoft Teams Microsoft Teams has become an integral part of organizational
communication, especially for remote teams. The platform facilitates discussions, project tracking, and note-taking. Implementing Strikethrough in Teams: Open a chat or a channel conversation. Type your message and highlight the text you want to format. While Teams does not have a built-in strikethrough feature via a direct shortcut, you can use
Markdown syntax: ~~text~~. When you send the message, it will render with strikethrough. Collaborative Benefits: Strikethrough in Microsoft Teams allows for transparent communication. For example, while working on a project timeline, team members can provide feedback and outline which tasks have been completed and which ones may need
re-evaluation. This feature fosters an open and collaborative environment. Advanced Uses of Strikethrough While the primary function of strikethrough is to indicate changes or deletions, it can also be employed in various creative and organizational strategies: Version Tracking: Using strikethrough can highlight what ideas or data points have been
discarded across multiple drafts, which can be helpful for keeping track of the evolution of concepts. Prioritization: In to-do lists or brainstorming sessions, strikethrough can prioritize tasks by showing which items have been completed while leaving others open for ongoing work. Feedback Mechanism: When providing feedback on collaborative
documents or during presentations, using strikethrough allows team members to visually see changes, leading to more constructive discussions. Time Management: In professional settings, you can utilize strikethrough in agendas or meeting notes to highlight decisions that have been made or tasks that are no longer necessary, thus keeping the focus
on current priorities. Conclusion The strikethrough feature is more than just a method for highlighting deleted content; it is a powerful tool for clarity and communication in various professional environments. Understanding how to utilize the strikethrough shortcut across platforms like Google Docs, PowerPoint, Sticky Notes, and Microsoft Teams
enhances productivity, collaboration, and organization. As teams increasingly rely on digital tools for communication and project management, knowing how to effectively employ strikethrough formatting can contribute significantly to the coherence and clarity of information shared and received. Overall, strikethrough not only simplifies the editing
process but also strengthens the collaborative efforts within teams, offering a transparent view of their workflows. Incorporating strikethrough effectively can transform how you present ideas, facilitate conversations, and organize tasks in a visually impactful way. By mastering shortcuts and formatting features across different applications, you can
enhance your productivity and ensure that your communication remains effective and engaging. Whether you are drafting a document, crafting a presentation, managing personal notes, or collaborating with a team, the strikethrough feature can become an invaluable part of your digital toolkit. In this post, we will discuss the keyboard shortcuts for
strikethrough in different applications, including Microsoft PowerPoint, Google Docs, Sticky Notes, Microsoft Teams, and Microsoft Outlook. A keyboard shortcut is a combination of keys on your keyboard that enables you to accomplish a task more quickly and efficiently when pressed together or in order. The Windows OS supports over 200 keyboard
shortcuts, which can be categorized into general or application-specific keyboard shortcuts. The application-specific keyboard shortcuts allow you to carry out specific tasks in a particular application using a set of keys instead of using the mouse button clicks.How to strikethrough textStrikethrough is a type of formatting in which a line appears
through selected text. The line indicates that the text has been crossed out or deleted. Following is an example of the strikethrough text:The Windows ClubStrikethrough tells the reader that the text is no longer relative. There may be a situation when you don’t want a piece of text in content but also don’t want to remove it completely. In that case,
you can just strikethrough the text, so that it remains available in the content for later reference or inclusion.Before we proceed further, let us understand that a keyboard shortcut may include a plus (+) sign or a comma (,) sign in between. The plus sign indicates that the keys need to be pressed together to make the shortcut work. While the comma
sign indicates that the keys need to be pressed one by one, in sequence.For example, to use the ‘Alt+Shift+5’, you have to press ‘Alt’, hold it, then press ‘Shift’, hold it, and then press ‘5’. While on the other hand, to use ‘Alt, H, 4’, you have to press ‘Alt’, let go of it, then press ‘H’, let go of it, and then press ‘4’.Now let’s take a look at the strikethrough
shortcut for Google Docs, PPT, Sticky Notes, Teams, and Outlook.Strikethrough keyboard shortcut for Google DocsTo strikethrough text using the keyboard, select the text, and then press the following key combination:Alt+Shift+5Alternatively, you can follow the steps mentioned below:Select the text.Click on the Format menu on top of the
document.Click on the Text option. A submenu will appear.Select the Strikethrough option.Also Read: How to Strikethrough text in Word or Excel.Strikethrough keyboard shortcut for Microsoft PowerPointTo strikethrough text in MS PowerPoint, select the text and then press the following keys in sequence:Alt, H, 4Alternatively, follow the steps
mentioned below:Select the text.Go to the Home tab.Expand the Font menu.Click on Strikethrough under Effects.Strikethrough keyboard shortcut for Sticky NotesTo strikethrough text in Sticky Notes, select the text and then press the following key combination:Ctrl+TAlternatively, you can click on the Strikethrough option located at the bottom of
the notes window.Strikethrough keyboard shortcut for Microsoft TeamsYou can use Markdown to enable keyboard shortcuts for strikethrough in Microsoft Teams. Markdown is a markup language that allows text formatting in a plain text editor without using HTML tags. Here’s how you can use your keyboard to strikethrough text in Microsoft
Teams:Place you cursor at the beginning of the text that needs to be strikethrough.Type ~Use the arrow key to move your cursor to the end of the text.Type ~ again.Alternatively, you can select the text and click on the Strikethrough option on top of the compose box.Strikethrough keyboard shortcut for OutlookTo strikethrough text in MS Outlook,
select the text and then press the following keys in order:Alt, O, 4Alternatively, you may follow the steps mentioned below to use the strikethrough effect on a word or phrase in Outlook:Select the text.Go to the Format Text menu.Click on the Strikethrough option.What is the shortcut for strikethrough in sticky notes?Sticky Notes supports keyboard
shortcuts to apply different formatting effects on text such as bold, italics, and strikethrough. To strikethrough a piece of text in sticky notes, select the text and then press Ctrl and T keys simultaneously. This will create a strikethrough effect on the selected text. That means the text will remain in the note, but marked as crossed out.Read: Delete
button does not show strikethrough when Track Changes is enabled in WordlIs there a shortcut for strikethrough in Outlook?Yes, there is a keyboard shortcut for strikethrough in Outlook. The shortcut is Alt, O, 4. Notice that there’s a comma sign in the shortcut. The comma indicates that you don’t have to press the keys all together, but you have to
press a key, then release it, then press another key, then release it, and so on. So after selecting the text, press Alt, release Alt, then press O, release O, then press 4, and finally release 4.Read next: Keyboard shortcuts and Hotkeys are not working in Windows.



